
talks.ox Documentation
Release 0.0.1

Mobile Oxford Team, Software Solutions, IT Services, University of Oxford

May 06, 2016





Contents

1 User Guide 1
1.1 Talk Editors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

2 Web Managers and Integrators 21

3 Developer Documentation 23
3.1 HTTP-API . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

4 Indices and tables 31

HTTP Routing Table 33

i



ii



CHAPTER 1

User Guide

1.1 Talk Editors

1.1.1 Apply to be a Talks Editor

To create Talks and Series (such as Seminar Series and Conferences), you need to apply to become a Talks Editor.

All members of the University are entitled to be a Talks Editor, if you are a student, please ask a member of staff to
approve your application.

There are two steps:

1. Log in to Oxford Talks (this will create an ordinary user account for you) at http://new.talks.ox.ac.uk

2. Send an email to oxtalks-contact@it.ox.ac.uk with the following:

• Your Name

• Department

• Your Email

• Email address of the member of staff approving your application (if you are a student)

If you are planning to share editing with other colleagues then ask them to log in and send us their details as well.

1.1.2 Logging in and out

You can log in using your Oxford SSO username and password.

Log in

• The Login button is on the far right of the toolbar at the top of the screen

• Click Login and you will be taken to the usual WebAuth page to sign in
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• Once you have signed in, clicking the Continue to button will take you back to Oxford Talks

Next Steps

If you haven’t already applied to be a Talks Editor then follow the instructions in the section Apply to be a Talks Editor

If you are already signed up as a Talks Editor, follow the instructions in:

• Create a talk - to make a start on creating or editing talks

• Create a series of talks - to begin a new seminar series or conference

Log out

The Logout button is also located at the far right of the toolbar at the top of the screen.

Note: Clicking this will only log you out of the Oxford Talks website. You will still be logged in to any other web
pages you have logged in to with your Single Sign On username and password using the WebAuth page. If you really
want to sign out of everything, then close down your browser.
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1.1.3 Create a talk

Get started by creating a new talk.

The New Talk form

You can get to the New Talk form by clicking New Talk on the toolbar at the top of the screen.

Alternatively click Dashboard and then the New Talk button.

The New Talk form is quite lengthy, but the most important fields are grouped at the top:

Title

Get started immediately by typing the Title.

If you don’t yet know the title you can leave the Title field blank and tick the Title TBA box.

Note: For more information on scheduling talks before you have all the information see the Editing and Publishing
section of this guide.
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Start and End

Clicking anywhere in the Start field will make the calendar picker appear. Select the month and day and the picker
will automatically switch to time options.

Once you have finished selecting the Start date and time, the End field will automatically be set to an hour later. You
can change this by clicking in the End field.

Speakers

1. If you start typing a speaker’s name, you may find they are already in the system. If they aren’t then, click
Create new person to reveal the form to add a new speaker.

2. You may add as many speakers as you like.

You will find that Talk organisers and Talk hosts can be added in the same way. Scroll down to find these fields.
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Note: The section Change speaker / host / organiser details explains how to edit this information.

Venue

1. Start typing the name of a building or location and it will be automatically looked up in the University’s OxPoints
system. The address and map information will be retrieved automatically and displayed with the rest of the talk
information.

2. Specific details - the room name or number, or information about how to gain entry - can be added in the box
below.

If the talk doesn’t take place in the University then leave the Venue field blank and use the Venue Details box.

You will find that the Organising department can be added in a similar way. Scroll down to find that field.

Saving

When you’re ready, save the talk by clicking either:

• Save and add another Talk to go straight to a new Add Talk form

• Done to preview the talk you’ve just created

If you want to cancel your changes (before you save them) then just click the back button in your browser.

More Information

Now that you have run through the editing basics, look at the following sections for guidance on the other fields on the
form:

• Publicising your talk - explains how the Abstract, Topic and Organising department fields can help get your
talk included in more listings

• Formatting the abstract - provides a quick cheat sheet on how to add headings, lists and links to the Abstract
field

• Editing and publishing - gives you tips and tricks on how to schedule talks before you have all the information
available

• Sharing editing - how to assign other editors to your talk
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1.1.4 Create a series of talks

A series of talks could be a seminar series, a conference, a workshop or a similar event.

via Add Talk

1. Click New Talk on the toolbar and start adding your talk information

2. Tick the Series box.

3. Click the New series button.

The Add a new series form will pop up. Not all information about a series can be added via the pop up form - so you
may need to go to the Dashboard to add further information later.

via the Dashboard

Creating a series via the Dashboard means you can add all the information about a series in one go:

1. Click Dashboard at the top of the screen
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2. Select Series from the filter on the left hand side

3. The New series button should appear. Click this to get the New Series form

Title and Description

• Make sure your Title is not too generic - including the short name or acronymn of your department is helpful
e.g.: ‘WIMM Monday Seminars’ rather than just ‘Monday Seminars’

• The text in the Description can be formatted - see Formatting Text for more information

Organisers and Organising Department

Both the Organisers and Organising department fields work in the same way as for a talk, start typing to find the
individual or unit you want.

Now, when you create talks and assign them to this series, you’ll find that they inherit the organisers and organising
department.
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Timing and Web Address

• The Timing field allows you to add a short piece of text describing times and dates. For instance you might
want to indicate that your Monday Seminars occur every Monday in Full Term at 11am.

• Use the Web address field if your series or conference has a dedicated website or page. Remember to prefix the
address with ‘http://‘ or ‘https://‘.

Saving

When you’re ready, save the series by clicking either:

• Save and add another to go straight to another New series form

• Done to preview the series you’ve just created

If you want to cancel your changes (before you save them) then just click the back button in your browser.
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1.1.5 Editing and Publishing

Editing

1. Click Dashboard in the tool bar at the top of the screen to view all the talks and series you have created.

2. The column on the left allows you to switch between talks, series and people (speakers, organisers and hosts)

3. Filters allow you to narrow the list down further

Note: The default view is to show all future talks. You may want to restrict this to Talks Editable by me at the
bottom of the list of filters.
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Checking for missing information

You can schedule and publish a talk even if you don’t have all the details:

• You must supply the Date and Time

• Leave other fields on the form blank

• Use the Title TBA check box to leave the Title blank

Use the Dashboard Missing Information filters to identify talks with information still to be supplied:
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Here, the list of talks has been narrowed down to

• editable by me

• still to take place

• without a speaker

Publishing

Talks are flagged as In preparation when you first create them.
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To change this status:

• On the Talk Edit form scroll down to find the Status field

• Switch the radio button to Published.

You can switch back to In preparation at any time.

What does ‘In preparation’ mean?

A talk is flagged In preparation so that everyone is aware that the information is subject to change or incomplete.

Note: In preparation talks are:

• Not Private - all talks can be viewed if you know the web address

• Can’t be found through the search interface or the lists on the Oxford Talks website

1.1.6 Formatting text

Formatting using the Textile markup language

Text in the Talk Abstract field and the Series Description field can be formatted using Textile markup.

The basics are very easy to remember:

Headings (Abstract only)
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h1. Main Heading
h2. Sub heading

Paragraphs

Separate paragraphs with a blank line.

This is a new paragraph.

Bold and Italic

*This will create bold text*
_This will create italics_

Bullet Points and Numbered Lists (Abstract only)

* First Item

* Second Item
# Item One
# Item Two

Links

A web address should convert into a link automatically when you save the talk. To give the link a title rather than just
show the web address:

"Oxford University":http://www.ox.ac.uk

To make an email clickable use the following:

"$":mailto:joe.blogs@ox.ac.uk

If you need more, there is a comprehensive manual on txstyle.org

Pasting from Word

You can copy and paste from Word, but you will need to format the text again.

If you have a number of abstracts and lots of formatting, then try:

• adjusting the styles in your Word document following the guidelines below

• saving your Word document as a plain text file

• opening the file in a plain text editor (e.g.: Notepad) and copying from there

Headings

• Format > Style > Modify > Numbering ...

• Choose Numbering, click any numbering style and click the Customize ... button

• Set the Number style to None and type ‘h1’ in the Number format box

Bullet Points

• Format > Bullets and Numbering

• Click the Customize ... button

• Select an asterisk from the Bullet Character options

Numbered Lists
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• Format > Bullets and Numbering

• Click the Customize ... button

• Set the Number style to None and type ‘#’ in the Number format box

Other useful tools

• Table converter - turning a CSV file (e.g.: exported from Excel) into a Textile table of information

• Pandoc - open source software to convert to Textile from other formats

1.1.7 Publicising your talk

Oxford Talks will automatically compile listings of talks in subject areas and can pull together all talks belonging to a
department or a division. The more information you can give about a talk, the wider it will be publicised.

Adding your talk to topic listings

We use Topics to group talks into subject areas. Assigning one or more topics to your talk will mean that it will have
a better chance of being discovered and readvertised by specialist communities.

Go to the Topics field on the Add talk form. Start typing and you will be offered options from the Library of Congress
Subject Headings. Once you’ve found and selected a topic it will be highlighted in blue. To remove it, just click on
the ‘X’.

Please start with broader topics first e.g.: ‘Neuroscience’ or ‘Ancient History’, and then add narrower topics in the
specialist area of the talk e.g.: ‘Molecular Neurobiology’ or ‘Naval Warfare’.

Adding your talk to department listings

We use the University’s complete list of units, buildings and locations, Oxpoints, to specify the department or unit a
talk belongs to.

Start typing the name in the Organising department field in either the Series or the Talk editing form.

Once you’ve assigned a department or unit to a Series it will be automatically assigned to any Talks you then add to
the Series.
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If you choose a sub-department or unit, then the talk will also appear in the parent department and division listings.

Adding an abstract

Keywords in the talk abstract will be used for searching, so please add the abstract if you have it.

Public lists (coming soon)

As well as topic and department listings, there may be some more ad hoc listings you would like your talk to be
included in. In the next version of Oxford Talks, public lists can be created to collect together talks relevant to a
particular theme, enterprise or project within the University - Athena Swan is a good example.

1.1.8 Last minute changes

You may want to draw attention to last minute changes to your talk - a change of venue or a cancellation

Special message field

The Special message field is intended just for this purpose. Messages here will appear prominently in the talk display.

1.1. Talk Editors 15
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1.1.9 Sharing editing

You can share the editing of a series or an individual talk with another Talk Editor

Series of Talks

Start typing the email address of another Talks Editor in the Other Editors field.

You may add as many editors as you like. The Edit button for the Series will then appear in the other editors’
Dashboards

Note: the field will automatically complete only if the Talks Editor has already been signed up to Oxford Talks. If
their email doesn’t appear, make sure they have been signed up. For more information see Apply to be a Talks Editor.
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Individual Talks

If you share editing of a Series with a Talks Editor, then they will have the rights to edit all the Talks in that series too.

You can adjust this in the Other Editors field of the individual talk.

1.1.10 Change speaker / host / organiser details

Speaker, host and organiser details can be changed using the Person edit form

Be careful!

Any Talks Editor can change the details of any person appearing in Oxford Talks as a speaker, host or organiser. When
you edit their name or affiliation, the changes will trickle down to every talk this person has been assigned to -
including past talks. If someone has moved department or been promoted, it is perfectly OK to create a new person
entry for them in their new role.

Find the person

1. Click Dashboard on the toolbar at the top of the screen

2. Select the People filter

3. Although you can go straight to the Person Edit form from here by clicking the Edit button, it is a good idea to
click on the name of the person first and review what talks they appear in.
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Check details

Click through to review details of their talks. Any changes you make to their entry will be reflected in all these talks.

Person Edit form

• In addition to Name and Affiliation, you can add a Web address - this is a good way to provide more details
about a speaker

• To cancel your changes before saving, use the back button on your browser

Deleting

If you need to delete a person, please contact the Oxford Talks Administration.

1.1.11 Contact Us

Please send all queries to the helpdesk at:

oxtalks-contact@it.ox.ac.uk

If you are reporting a problem, then please try to include as much detail as possible in your email.

We are also happy to have feedback and will happily consider requests and ideas for new features.
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1.1.12 Migrating between the Old Oxford Talks and the New

Oxford Talks is about to be updated with its first phase - the editing interface, currently called New Talks.

Series and Lists

In Old Talks everything is a list.

In New Talks we make a distinction between:

• series which is where a talk ‘belongs’ when you create it - for instance a seminar series or a conference - things
you organise yourself, like your Departmental Friday Seminars, or regular Club meetings.

• list which is a collection of talks owned and organised by other people (e.g. All the Talks in a Department or
Interesting Talks about Goldfish)

Editing Interface

• series of talks will now be created and edited in the new editing interface - New Talks (http://new.talks.ox.ac.uk).

• lists of talks should still be pulled together in the Old Talks website (http://talks.ox.ac.uk).

Note: You will need to apply to be a Talks Editor to use the new editing interface.

Updating Series and Talks

All upcoming series and talks have been migrated to the New Talks editing interface (http://new.talks.ox.ac.uk) so that
you can edit them there.

If you change something in New Talks it should get pushed to the Old Talks website (http://talks.ox.ac.uk).

Note: This only works one way. If you change something on the old Talks website it won’t get pushed to the new
interface.

Series that didn’t get migrated over

If a series didn’t have any upcoming talks we didn’t migrate it.

If the series is still current you can:

1. Either - create a brand new series in New Talks - this will appear on the Old Talks website

2. Or - ask us to migrate the old series - just contact us with the Old Oxford Talks web address of the series

Note: The second option will keep that series connected to any other collected lists in Old Talks, with the first option
you will have to add your new series to any collected lists and retire your old series

I can’t see my List in the New Talks!

Is it a collected list? If so it won’t appear in the New Talks editing interface as, for the moment, we are still using the
Old Talks website to make collections, set up reminders etc.
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Is it a seminar series or conference or similar? Get in touch with us and we’ll ensure that you get a series set up and
that it pushes to the corresponding series on the Old Talks website if that is what you want.

I’ve changed something on the Old Talks site but I don’t see it on New Talks!

This is correct. If you want to edit or add, please do that in the New Talks editing interface and allow New Talks to
push the information to the Old Talks website.

1.1.13 Talks Editors and Talk Organisers

Talk and Series Organisers

Organisers

• are involved in the practical organisation of a talk or a series of talks

• are the main point of contact for enquiries about the event.

Organisers are added to Oxford Talks in the same way as speakers and hosts. If they don’t appear in the drop down list
as you type then you can use the Add Person button to add them quickly to the system.

Very often organisers will also be the people who add information about the talk to Oxford Talks - if that’s the case
then they will also need to be signed up as a Talks Editor.

Talks Editors

Talks Editors

• have the rights to edit the information in Oxford Talks

• must have an Oxford University Single Sign On account and have applied to be a Talks Editor

• can create new series or talks

• can be added as an editor to other talks and series.

Once a Talks Editor has been signed up, you should be able to add them to the list of editors for a series or talk by
typing their email address.

Why the two roles?

The old Oxford Talks had just one role - the List Manager was the person who added and edited lists and talks and
was also the point of contact for enquiries. Anyone could add or edit talks and lists.

When we designed the new system, feedback from administrators was that they would prefer editing and adding of
talks to be restricted, so we created the Talks Editor role and put in the option to specify an organiser without having
to go through the process of signing them up to be an Editor as well.

20 Chapter 1. User Guide



CHAPTER 2

Web Managers and Integrators

An example widget to get you started with embedding talks in your own webpages can be found here:

https://github.com/ox-it/talks.ox-js-widget

The widget uses JavaScript to write a table, list or calendar view of selected talks to an HTML page. You can specify
the criteria to select the talks you want.

• Widget Documentation Overview

• Parameters Reference
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CHAPTER 3

Developer Documentation

3.1 HTTP-API

3.1.1 Summary

Formats: JSON, XML

The API is able to return either XML or JSON, depending on the ‘Accept’ header in the request. By default a web
browser will specify XML in the request. Note curl doesn’t specify any preference, so the API will respond with json.

To ensure you get xml back, add an Accept header to your request:

curl https://new.talks.ox.ac.uk/api/series/041a5cc6-d65a-4dec-967d-3adc5162cea3 -H "Accept: application/xml"

For a more detailed example of the API in use, see the JavaScript widget documentation.

3.1.2 Retrieve Talks via Search

GET /talks/search
Search for Talks

Example request:

GET /api/talks/search?from=today&topic=X HTTP/1.1
Host: talks.ox.ac.uk
Accept: application/json

Example response:

HTTP/1.1 200 OK
Content-Type: application/json

{
"_links": {

"self": {
"href": "http://talks.ox.ac.uk/api/talks/search?from=01/01/01"

},
"next": null,
"prev": null

},
"_embedded":

{
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"talks": [
{

"_links": {
"self": {

"href": "/api/talks/fa67d13a-f17d-471d-b8cc-33b3d7759956"
},
"talks_page": {

"href": "/talks/id/fa67d13a-f17d-471d-b8cc-33b3d7759956/"
}

},
"title": "What can babies with Down syndrome possibly tell us about Alzheimer's dementia in adults?",
"start": "2015-01-29T18:00:00Z",
"end": "2015-01-29T19:00:00Z",
"formatted_date": "29 January 2015, 18:00",
"formatted_time": "18:00",
"description": "It may seem paradoxical to focus on babies ...",
"_embedded":
{

"speakers": [ ],
"venue": {

"_links": {
"self": {

"href": "//api.m.ox.ac.uk/places/oxpoints:50009121"
}

},
"name": "Mary Gray Allen Building",
"map_link": "//maps.ox.ac.uk/#/places/oxpoints:50009121"

},
"organising_department": null,
"topics": [

{
"uri": "http://id.worldcat.org/fast/806532",
"label": "Alzheimer's disease"

}, {
"uri": "http://id.worldcat.org/fast/890050",
"label": "Dementia"

}
]

}
}
]

}
}

Query Parameters

• from – Date to start filtering on (mandatory). Format should be dd/mm/yy OR ‘today’ or
‘tomorrow’

• to – Optional date to end filtering. Format should be dd/mm/yy OR ‘today’ or ‘tomorrow’

• subdepartments – Optional. Defaults to true. If true, include all sub-organisations of the
specified department within the search

The below parameters can each be repeated multiple times

Query Parameters
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• topic – Topic URI

• venue – Search for talks taking place at the location specified by the oxpoints ID

• organising_department – Search for talks whose organising department is the organisation
specified by this oxpoints ID

• speaker – Search for talks at which the specified person is a speaker. Supply the unique
slug for the person e.g. ‘d47e2458-af73-4bc1-bf04-3c275e1c1254’

The response can be either in XML or JSON dependent on the ‘accept’ header in the request.

Status Codes

• 200 OK – query found

• 400 Bad Request – Bad request (could happen if some parameters are missing or incorrectly
formed such as from)

• 503 Service Unavailable – Service not available

3.1.3 Retrieve Series

GET /series/
Retrieve series by ID, including all talks

Example request:

GET /api/series/series-id
Host: talks.ox.ac.uk
Accept: application/json

Example response

<root>
<id>1</id>

<title>A conference</title>
<description>A conference featuring a diverse array of groups</description>
<department_organiser/>
<events>
<list-item>
<slug>
deformation-and-melts-litosphere-astenosphere-boundary

</slug>
<url>
/talks/id/deformation-and-melts-litosphere-astenosphere-boundary/

</url>
<title>
Feedbacks between deformation and melts in the lithosphere-asthenosphere boundary

</title>
<start>2014-12-10T12:00:00Z</start>
<end>2014-12-10T14:00:00Z</end>
<description>Geo sciences</description>
<formatted_date>10 December 2014, 12:00</formatted_date>
<formatted_time>12:00</formatted_time>
<speakers>
<list-item>
<id>3</id>
<name>Dr Andrea Tommasi</name>
<bio>Geosciences Montpellier</bio>
<title>Dr Andrea Tommasi, Geosciences Montpellier</title>
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</list-item>
</speakers>

<organisers/>
<hosts/>
<happening_today>False</happening_today>
<audience>oxonly</audience>
<api_location>...</api_location>
<api_organisation>...</api_organisation>
<api_topics>...</api_topics>
<class_name>Event</class_name>
</list-item>

</events>
</root>

Parameters

• id (string) – The unique slug identifier for the series

Status Codes

• 200 OK – Series found

• 404 Not Found – Series not found

• 503 Service Unavailable – Service not available

3.1.4 Retrieve Talks via ID

Endpoint to retrieve information about talks

All the responses conform to the HAL specification.

GET /talks/(string: id)
Retrieve talk by ID

Example request:

GET /api/talks/fa67d13a-f17d-471d-b8cc-33b3d7759956
Host: talks.ox.ac.uk
Accept: application/json

Example response:

HTTP/1.1 200 OK
Content-Type: application/json

{
"_links": {

"self": {
"href": "/api/talks/fa67d13a-f17d-471d-b8cc-33b3d7759956"

},
"talks_page": {

"href": "/talks/id/fa67d13a-f17d-471d-b8cc-33b3d7759956/"
}

},
"title": "What can babies with Down syndrome possibly tell us about Alzheimer's dementia in adults?",
"start": "2015-01-29T18:00:00Z",
"end": "2015-01-29T19:00:00Z",
"formatted_date": "29 January 2015, 18:00",
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"formatted_time": "18:00",
"description": "It may seem paradoxical to focus on babies ...",
"_embedded":
{

"speakers": [ ],
"venue": {

"_links": {
"self": {

"href": "//api.m.ox.ac.uk/places/oxpoints:50009121"
}

},
"name": "Mary Gray Allen Building",
"map_link": "//maps.ox.ac.uk/#/places/oxpoints:50009121"

},
"organising_department": null,
"topics": [

{
"uri": "http://id.worldcat.org/fast/806532",
"label": "Alzheimer's disease"

}, {
"uri": "http://id.worldcat.org/fast/890050",
"label": "Dementia"

}
]

}
}

Parameters

• id (string) – The unique slug identifier for the talk

Status Codes

• 200 OK – Talk found

• 404 Not Found – Talk not found

• 503 Service Unavailable – Service not available

GET /talks/search
Search for events

Example request:

GET /api/events/search?from=today&topic=X HTTP/1.1
Host: talks.ox.ac.uk
Accept: application/json

Example response:

HTTP/1.1 200 OK
Content-Type: application/json

{
"_links": {

"self": {
"href": "http://127.0.0.1:8000/api/talks/search?from=01/01/01"

},
"next": null,
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"prev": null
},
"_embedded":

{
"talks": [
{

"_links": {
"self": {

"href": "/api/talks/fa67d13a-f17d-471d-b8cc-33b3d7759956"
},
"talks_page": {

"href": "/talks/id/fa67d13a-f17d-471d-b8cc-33b3d7759956/"
}

},
"title": "What can babies with Down syndrome possibly tell us about Alzheimer's dementia in adults?",
"start": "2015-01-29T18:00:00Z",
"end": "2015-01-29T19:00:00Z",
"formatted_date": "29 January 2015, 18:00",
"formatted_time": "18:00",
"description": "It may seem paradoxical to focus on babies ...",
"_embedded":
{

"speakers": [ ],
"venue": {

"_links": {
"self": {

"href": "//api.m.ox.ac.uk/places/oxpoints:50009121"
}

},
"name": "Mary Gray Allen Building",
"map_link": "//maps.ox.ac.uk/#/places/oxpoints:50009121"

},
"organising_department": null,
"topics": [

{
"uri": "http://id.worldcat.org/fast/806532",
"label": "Alzheimer's disease"

}, {
"uri": "http://id.worldcat.org/fast/890050",
"label": "Dementia"

}
]

}
}
]

}
}

Query Parameters

• from – Date to start filtering on (mandatory). Format should be dd/mm/yy OR ‘today’ or
‘tomorrow’

• to – Optional date to end filtering. Format should be dd/mm/yy OR ‘today’ or ‘tomorrow’

• subvenues – If true, include all sub-locations of the specified venue within the search
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• subdepartments – If true, include all sub-organisations of the specified department within
the search

The below parameters can each be repeated multiple times

Query Parameters

• topic – Topic URI

• venue – Search for talks taking place at the location specified by the oxpoints ID

• organising_department – Search for talks whose organising department is the organisation
specified by this oxpoints ID

• speaker – Search for talks at which the specified person is a speaker. Supply the unique
slug for the person e.g. ‘james-bond’

The response can be either in XML or JSON dependent on the ‘accept’ header in the request.

Status Codes

• 200 OK – query found

• 400 Bad Request – Bad request (could happen if some parameters are missing or incorrectly
formed such as from)

• 503 Service Unavailable – Service not available
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CHAPTER 4

Indices and tables

• genindex

• modindex

• search

31



talks.ox Documentation, Release 0.0.1

32 Chapter 4. Indices and tables



HTTP Routing Table

/series
GET /series/, 25

/talks
GET /talks/(string:id), 26
GET /talks/search, 27
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